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INTRODUCTION 
 
Whether you are head of communications, Human Resource manager or PC helpdesk manager, you 
have no effective tool to broadcast and instantly display urgent messages! Email is frequently simply 
ignored and an Intranet requires a user to look for news first. Netpresenter pushes your news 
automatically to desktops and TV's in seconds, instantly visible to all your personnel. 
 
If you have an Intranet, you probably know that even the best Intranets can  
suffer from a lack of popularity. Netpresenter allows you to publish your Intranet headlines 
automatically on its Screensaver  or Desktop (Pop-up) Player . With one click on Netpresenter 
players such as the Screensaver , users can click-through to the Intranet, greatly enhancing the 
effectiveness of your Intranet. 
 
This “Getting Started” document shows you how to quickly create a presentation with the 
Netpresenter Editor . Next, you will learn how to display the presentation automatically on the PCs in 
your network with the Netpresenter Players . After reading this document, you will have learned that 
Netpresenter is a powerful tool for improving your internal communications, reducing the abundance 
of Emails, and popularizing your Intranet . 
 
The Software Components 
 
The user-friendly Netpresenter  Editor  is as easy to use as any presentation program.  Your 
presentation can then become your corporate Screensaver using the Netpresenter  Screensaver 
Player.  By simply copying and pasting  Hyperlinks  in your presentation you can turn your 
corporate screensavers into a pro-active front end to your intranet.  Additionally the Netpresenter  
Desktop (Pop-up) Player  will display your presentation anywhere on the network on demand either 
by the user, or forced up by you, for emergency or critical communications. 
 
Your presentations can also be displayed in other areas, such as the reception area, company 
cafeteria, or the factory unit etc. with the Netpresenter TV Player . 

 
 
Netpresenter 3.8: What’s new? 
 

- Text wrap allows the player to automatically wrap text around an object or reclaim empty 
space otherwise used for displaying for example an image. This feature is typically used in 
combination with the Message Server.  

- Url's will now be opened in new browser windows instead of re-using existing ones  

- Remote configuration of the player is now possible, also over the internet. This allows for 
easy remote administration.  

- Advanced scheduling in combination with the Message Server (version 5.1 and up). For 
example slides can be scheduled to display from April 1 2006 12:00 until April 31 2007 16:00, 
every Wednesday.  
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NEW FEATURES IN NETPRESENTER 3.7: 
 

- Netpresenter 3.7 now plays audio and video files using Microsoft’s DirectShow framework. It 
now supports more video and audio codecs (including .mp3). Also new is that slides will 
display until the last video fragment has finished playing. 

- Automatic slide change when a video has finished is now possible, for example by setting the 
slide time to 0 (WAIT).  

- Power Management options: Optionally the screensaver can be made more effective by 
denying monitor power down during office hours 

 

 

NEW FEATURES IN NETPRESENTER 3.6: 
 

- Script support. The results of PHP, Perl and other web scripts can now be displayed in the 
players, making content management system integration, or grabbing content from websites 
seamless 

- Add-on module support. Modular expansion of the player is now possible. The first (optional) 
module is a queue system for displaying queue numbers (who's turn is next) on a 
Netpresenter TV Player 

- Support for Unicode (double byte code) text files. Players can now display non-western 
languages such as Chinese, Japanese, Arab and Hebrew. 

 
 
NEW FEATURES IN NETPRESENTER 3.5:  

 
 

- Improved scaling and 16:9 support of players 

- An emergency alert pop-up for immediate information to all employees in the event of an 
emergency 

- Enhanced integration with content management software 

- Accelerated display of presentations and smoother screen transitions, thanks to an optimized 
graphic engine using on average 90% less CPU and network resources 

- Enhanced multimedia-video compatibility (MCI support) 

- Supports the energy saving mode (power/screen shutdown)  

- Support of large installations on a single web or FTP server, thanks to improved scaling and 
optimized use of the network 

- Thin client support for Citrix clients and Windows based Terminal servers 
- Hyperlinks and dynamic content on each Microsoft Windows 32-bit version 

- Enhanced support of Microsoft Windows security policies 

- Easier network installations and lower installation costs, thanks to a new installation module 
(MSI) 

- Channel selector: Possibility to allow users to quickly select another predefined channel. 
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MINIMAL OPERATING SYSTEMS REQUIREMENTS : 
 
 
16Mb Ram, 10 Mb free HD space. 
 

- Windows 95/98 SE/Me 
- Windows NT 4.0 SP3 or later  
- Windows 2000 SP1 or later 
- Windows XP (all Service Packs) 
- Citrix 

Tips: 

Netpresenter offers some features that are not immediately  visible from operating the Editor: 

- Popup  
To make a channel pop-up, set a slide’s priority to 10 in the editor, as shown below (Slide 
tab): 

 

To assure that alert messages reach the recipients on time, we recommend lowering the poll 
interval. Select the schedule tab of the Player’s property dialog and set the poll interval to for 
example 1 minute: 

 

(Also see the section titled “how to configure Netpresenter with the Netpresenter Editor to 
popup). 
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- Video  
In the Netpresenter editor move the slider that indicates a slide’s display duration all the way 
to the left until the numerical indicator for duration displays “wait”. Netpresenter players (3.7 
and up) will wait until the last video to be displayed in an object has finished  before 
advancing to the next slide. When setting the slide’s duration to “wait” AND selecting the 
“play and loop” option for the video, the slide will play the video forever.  

 
 
Best is to use the player for previewing the channels containing video, since it supports far 
more different codecs.. 

- After creating a channel with the Netpresenter Editor, always check it first in the Netpresenter 
Player. The 3.5 and up Player scales differently (The player scales in all directions, while the 
editor imposes a width:height ratio of 4:3). Also the 3.7 player plays more types of video files 
as the editor. 

- Optimal setting for terminal server clients  only: 
Turn off  the following options for optimal settings for thin clients; 

      

  

 

 

 

Preferably the images of presentations used on thin clients are the same size as the screen 
resolution. E.g. use a 800x600 background if your screen resolution is the same. This saves 
CPU time. 

 
Use visual transitions 
Download and play multimedia files 
Download attachment 
Scale slide to fit 
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INSTALLING NETPRESENTER 

 
1. Put the Netpresenter CD in your  
 CD-ROM player. Skip steps 2 .. 4 
            if the installation starts  
            automatically. 
 
2. Click Start , and then Run… 
 
3. In the Open field, type  
 d:\netpresenter\setup.exe.  
 (Replace d: by the drive letter  
 of your CD-ROM player,  
 if required.) 
 
4. Click OK. The Netpresenter  
 installation program will start.  
 Follow the instruction provided  
 on the screen. 
 
5. On the User Information   
 dialog, enter your name  
 and company name.  
 
If you do not enter a serial number ,  
you can use Netpresenter for 30 days .  
After that period the Save option of the editor 
will be disabled. 
 
 
 
 

 STARTING THE EDITOR 
 
1. Click Start , Programs , and then Netpresenter .  
 You will see four menu items:   
 
Editor  is the Editor, which you use to create your presentations. 
Desktop Player  is the Player, which will play your presentations. 
Properties  displays a configuration screen for the Desktop (Pop-up)  
Player  and Screensaver . 
 
2. Select Editor  to start the Editor. 
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  THE EDITOR 
 

The Editor  is the program you use to create your presentations. These presentations can range from 
simple ones that contain just one slide to complex ones consisting of a large number of slides with 
numerous objects  such as images, texts, video clips, or even hyperlinks  to web pages. 
 
 
3. MAIN MENU  
4. Contains all the co  

and.

MAIN MENU  
Contains all the 
commands and options 
available within 
Netpresenter. 

PREVIEW PANE 
Displays the slides. Click on the  
center of a slide to edit it. 

 

TOOL BAR  
Offers easy access to 
the most frequently used 
options from the Main 
Menu. 

PROPERTY SHEETS 
Using the tab pages you can  
edit the selected slide or object. 
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THE TOOL BAR  
 
The Tool Bar offers easy access to the most frequently used options from the Main Menu. These 
options can  
also be found on the Main Menu. 

 
 
 
 
 
 
 
 

 
 

PLAY 
Plays the 
presentation. 

VIEW 
Toggles 
between  
Slide Editor and   
Organizer view. 

PREVIOUS 
SLIDE  
Shows the 
previous slide. 

ADD SLIDE 
Adds a  
new slide. 

SAVE 
Saves the 
presentation. 

PROPERTIES 
Shows or 
hides the 
Properties 
Sheets. 

RELOAD 
Reloads the 
slide. 

NEXT SLIDE 
Shows the next 
slide. 

DELETE SLIDE 
Deletes the  
selected slide. 

SELECT OBJECT  
Click here to activate 
the object selection 
tool. 

HELP 
Opens the Help 
file. 

FONT SIZE 
Sets the font 
size. 

 

RECTANGLE, ELLIPSE, ROUNDED 
RECTANGLE, POLYGON  
Inserts an object with the selected 
shape. 

FONT 
Selects the font to use. 
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CREATING A SIMPLE PRESENTATION 
 
Adding a Picture: 

 
1. Click on the center of the  

 slide. The slide will now  
 completely fill the Preview pane. 

   
 
 
2. Select the Image tab . 
 
 
 
 
 

 3. Click File ... 
 
 
 
 
 
 
4. Select for example C:\ProgramFiles\Netpresenter\Demo\Slide1a.jpg    

  
 
 
 
 

 
5. Click Open to insert the  

 image. 
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Adding text: 
 
6. Click the Text tab . 
 
7. Enter some text. For  
 example: Your Name  
 
Adding an Effect: 
 
8. Select the FX tab. This is  
 where you select the type  
 of transition. 
 
9. Select the required effect.  
 
 
 
10. Click the             button to play  
 the presentation full-screen.  
 
 
11. Click the right-hand mouse button  
 or press [ESC]  to return to the Editor. 
  
 Now add a new slide  by clicking the                button on the Tool Bar.  
 
 
12. Add a picture to the new slide (or repeat step 1 to 5). 
 
 
 
Adding an Object: 
 
13. Click the Rectangle button  
 on the Tool Bar . The mouse  
 cursor will change into a cross. 
 
14. Create a rectangle by keeping  
 the left-hand mouse button  
 pressed down while moving  
 the mouse. 
 
 
 
15.  Click the Object to select it. 
 
16.  Add some text (or repeat  
 step 6 to 7) . 
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17. Select the Color tab . 
 
 
18. Click the Type dropdown  
 list, and then select  

Transparent . 
 
 
 
 
 
 
Adding a hyperlink: 
 
19.  Click the Object to select it. 
 
20. Select the Branch tab . 
 
21. In the Branch to … field,  
 type a web address (URL).  
 For example:  
 http://www.netpresenter.com . 
 
22. Select the Close Presentation  
 after Branch  checkbox.  
 This will close the presentation  
 when the web browser opens. 
 

23. Click the    button to play the presentation, and then click on the hyperlink. Your web 
browser will open, and display the web page you specified. 

 

Now try adding more slides by clicking the    button. 
 
The Properties Sheets refer to the Object, if no Object is selected it refers to the  
background.  
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  PUBLISHING YOUR PRESENTATIONS (EDITOR) 

 
To have the Desktop (Pop-up)  or Screensaver  Player play your presentation from the network, the 
presentation needs to be published to a network drive or a website. 
 
1. Click File  on the Main  
 Menu, and then click  
 Copy. 
 
2. A dialog appears as  
 displayed on the right. 
 
3. Select the folder where  
 you want to save the  
 presentation. 
 
4. In the File name  field,  
 type a name for your  
 presentation. For example:  
 test1. 
 
5. Click Save. 
 
Of course, you can also use the Save or Save as... options on the File menu to (temporarily) save 
your presentation locally, and to prevent loss of work. However, to publish your presentation you will 
have to use the Copy  option. (Only the copy function correctly copies the channel and all the images 
and multi-media file it uses to a public location.)  
 
For more information on this topic, see the Netpresenter Online Help or read the Manual. 

 
 
  THE DESKTOP (POP-UP) PLAYER  

 
The Pop-up Player automatically detects and downloads new presentations from a network drive. It 
automatically pops up when detecting the new presentation. If the pop-up function is disabled, the 
Pop-up Player icon will change color when a new presentation is detected. The presentation can then 
be manually started by clicking on the Pop-up Player icon. 
 
To open the Desktop (Pop-up) Player:  
 
1. Click Start, Programs , and then Netpresenter.   
 
2. Select Desktop Player  to start the Pop-up Player . 
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  3. When the player has started, you will see the Desktop (Pop-up) Player  

 icon  in the task bar. 
 
4.  Clicking the Minimize button            will hide the Player again. 
  
 Clicking the Close button              will stop the Player. 
 
 
 

  NETPRESENTER SCREENSAVER 
 
A complete Netpresenter installation also includes the Netpresenter Screensaver . This screensaver 
displays the same presentation as the Desktop (Pop-up) Player.  
 
To activate or deactivate the Netpresenter Screensaver: 
 
1. Click Start, Settings , and  
 then Control Panel . 
 
2. In the Control Panel , double- 
 click the Display icon. 
 
3. Click the Screensaver tab . 
 
4. If Netpresenter is not yet  
 selected in the Screensaver   
 dropdown list, do so now. 
 
5. In the Wait  field, you can select the    
 number of minutes the screensaver   
 should wait for inactivity before starting. 
 
6. Click Settings . The Netpresenter  
 Properties  dialog appears. 
 
 

  NETPRESENTER PROPERTIES 
 
The Netpresenter Properties  dialog is used to configure the Desktop (Pop-up) Player  and 
Screensaver . You can use this program to select the presentation you want to see, how often the 
Players should check the presentation for updates, and how the Desktop (Pop-up) Player  is to 
appear (normal mode, or full-screen mode). 
 
Opening the Netpresenter Properties 
dialog: 
 
1. Click Start, Programs,   
 and then Netpresenter.  
 
2. Select Properties . 
 
3. The Netpresenter Properties  
 dialog appears. 
 
 
(The Netpresenter Properties dialog can also be started by changing  
the settings of the Screensaver as discussed on the previous page).
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Selecting Your Presentation: 
 
1. Select the Channel tab. 
 
2. Click the browse button 

(…) to select a  
 presentation. This can  
 be any file with the .chn   
 extension. For example  
 startup.chn . 
 
 
 
 
 
 
 
 
Polling the Presentation for Updates:  
 
 
1. Select the Update Schedule tab.  
 
2. Make sure that both checkboxes  
 are selected (as in the example  
 displayed on the right). Then  
 indicate the time(s) at which the   
 Players on your computer  should     
 check for updates. For example,  
 every one (1) minute.   
 
 
 
 
 
 
 
Player Settings: 
 
1. Select the Players tab.  
 
2. Select Floating Window  or Fixed 

Window  to have the Desktop  
(Pop-up) Player  appear in a small  
window, or select Full Screen  if the  

 Desktop (Pop-up) Player  is  
 to take up the entire screen. 
 
3. Select "Popup on request ". 

When any slide in the  
 channel selected contains a slide  
 with priority 10, the player will  
 pop-up. With this feature important  
 messages will be brought under your 
             employee’s attention immediately.  

 

 



 

15 Getting started 
 

 
 
Alternatively select "Popup on every update ", to make players pop-up upon every change in the 
channel file, or select “Never popup” to prevent any popups. 
 
4. Select "User cannot exit Desktop Player " so that the user cannot close the player. The player will 
minimize to the taskbar notification area whenever a user attempts to close it. With this option set, 
users will always be notified upon the arrival of high priority messages (in accordance with the pop-up 
option selected above). (Note that when you allow the user access to a task manager or any kill utility 
he will still be able to ‘kill’ the process). 
 
 

  HOW TO CONFIGURE NETPRESENTER WITH THE NETPRESENTER EDITOR TO POPUP 

1. Start with making a simple presentation in the Netpresenter Editor  and save it using “File/Copy”. 
2. Open the Netpresenter Properties dialog  and go to the Channel tab. 
3. Change the Channel into the channel you just created. 
 

 
 
4. For demonstration purposes, set the update time as low as possible. Go to the Schedule tab and 

change it to "check every minute ", and make sure it is selected. 
 
 

 

 

5. Go to the Player tab and select "Popup on request " as shown below. 
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6. Close the Properties dialog  by clicking OK. 
7. Start the Netpresenter Player and minimize the player . (the icon of the remains in the taskbar 

notification area). 

     

8. Go back to the editor and change the "priority"  to 10 as shown below. (on the slide tab). 
 

 
 
9. Change  something in your channel, e.g. the background color. 
10. Save your channel and overwrite the existing presentation. 
11. Wait now, within one minute the player should pop-up , showing the updated channel. 

   



 

17 Getting started 
 
 
 
POPUP DEMO USING THE NETPRESENTER ALERT SERVER 
 

1. Set the player to our demo “Message and alert server channel” at http://demo.netpresenter.com”. 
Fastest is to use the channel selector, click on the players icon using the right mouse button and 
select “Message and alert server channel”: 

 
The player will start showing the current channel. 

2. To demonstrate the effect of popping up, minimize the player 
3. Now point your webbrowser to our demo Web form for generating alert messages at 

http://demo.netpresenter.com/: 

 
 

4. In the browser, Select “New Message”: 
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5. Enter the message and select “publish” 

 

6. On the overiew page, selet Publish(Pop-up) 
7. Now sit back (or continue working!) and wait for the popup to appear within the time set: 
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8. We also have a dedicated alert server which holds pre-defined scenarios and can be operated 
much faster 

9. You would select one of the pre-defined scenarios, for example the “Fire Alarm” scenario: 

 

10. Press the “Activate Alert” button. 
11. Now sit back (or continue working!) and wait for the popup to appear within the time set: 



 
 

20 Getting started 
 

 
 

NEW DESKTOP (POP-UP) PLAYER MENU OPTIONS 
 
When right clicking the Netpresenter icon           in the taskbar notification area, some new menu 
options can be seen. 
 

 
 
Channel selector  
If configured, the menu item “Select a channel” appears at the bottom of the context sensitive menu. 
When expanding this menu option (hover the mouse pointer over it), it is possible to select any pre-
selected channel. 
 
Start Screensaver now 
Start the screensaver immediately for security as well as information reasons. 
 
Disable Screensaver until next logon 
Stop the screensaver from firing up until the next logon, useful if you are doing a presentation from 
your laptop. 
 

 

 

 



 
 

 

 

 

 

 

 

 

 

 

 
 



 
 


